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・ The information in this document is current as of date of its publication. The information is subject to 
change without notice. For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all 
products and/or types are available in every country. Please check with an NEC sales representative 
for availability and additional information. 

 
・ No part of this document may be copied or reproduced in any form or by any means without prior 

written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document. 

 
・ NEC Electronics does not assume any liability for infringement of patents, copyrights or other 

intellectual property rights of third parties by or arising from the use of NEC Electronics products listed 
in this document or any other liability arising from the use of such NEC Electronics products.  No 
license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC Electronics or others. 

 
・ Descriptions of circuits, software and other related information in this document are provided for 

illustrative purposes in semiconductor product operation and application examples.  The incorporation 
of these circuits, software and information in the design of customer's equipment shall be done under 
the full responsibility of customer.  NEC Electronics no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.  

 
・ While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 

products, customers agree and acknowledge that the possibility of defects thereof cannot be 
eliminated entirely.  To minimize risks of damage to property or injury (including death) to persons 
arising from defects in NEC Electronics products, customers must incorporate sufficient safety 
measures in their design, such as redundancy, fire-containment and anti-failure features. 

 
・ NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” 

and “Specific”. 
 

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application.  The recommended applications of NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 
 
"Standard": Computers, office equipment, communications equipment, test and measurement 
  equipment, audio and visual equipment, home electronic appliances, machine tools, 
  personal electronic equipment and industrial robots. 
 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti- 
   disaster systems, anti-crime systems, safety equipment and medical equipment (not 
   specifically designed for life support). 
 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems,  
   life support systems and medical equipment for life support, etc. 
 
The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in 
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative in 
advance to determine NEC Electronics 's willingness to support a given application. 
 
Notes:  1." NEC Electronics" as used in this statement means NEC Electronics Corporation and also 
    includes its majority-owned subsidiaries. 

 2. " NEC Electronics products" means any product developed or manufactured by or for NEC 
  Electronics (as defined above). 
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CAUTION 

 
This is a Test- and Measurement equipment with possibility to be significantly 
altered by user through hardware enhancements/modifications and/or test or 
application software. Thus, with respect to Council Directive 89/336/EEC 
(Directive on compliance with the EMC protection requirements), this equipment 
has no autonomous function. Consequently this equipment is not marked by the 
CE-symbol. 

 
EEDT-ST-005-10 

 
CAUTION 

 
This equipment should be handled like a CMOS semiconductor device. The 
user must take all precautions to avoid build-up of static electricity while 
working with this equipment. All test and measurement tool including the 
workbench must be grounded. The user/operator must be grounded using 
the wrist strap. The connectors and/or device pins should not be touched 
with bare hands. 

 
EEDT-ST-004-10

 

 

 
 
 

 
Redemption of Waste Electrical and Electronic Equipment 
(WEEE) in accordance with legal regulations applicable in the 
European Union only: This equipment (including all 
accessories) is not intended for household use. After use the 
equipment cannot be disposed of as household waste. NEC 
Electronics (Europe) GmbH offers to take back the equipment. 
All you need to do is register at www.eu.necel.com/weee. 
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Regional Information 
 
Some information contained in this document may vary from country to country. Before using any NEC 
product in your application, please contact the NEC office in your country to obtain a list of authorized 
representatives and distributors. They will verify: 
 

• Device availability 
• Ordering information 
• Product release schedule 
• Availability of related technical literature 
• Development environment specifications (for example, specifications for 

third-party tools and components, host computers, power plugs, AC supply 
voltages, and so forth) 

• Network requirements 
 
In addition, trademarks, registered trademarks, export restrictions, and otherlegal issues may also vary 
from country to country. 
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1. Introduction 
V850ES/Fx3 – CAN it! is a demonstration kit for the V850ES/Fx3 32-bit RISC microcontroller. It supports 
On-Board debugging via the TK-V850 interface (monitor debugging) or via N-Wire. Additional FLASH 
programming and real time execution of application programs based on the V850ES/FG3 32-bit RISC 
microcontroller is supported by the V850ES/Fx3 – CAN it! demonstration kit. The board is prepared to be 
connected to user hardware parts such as digital I/O or analogue signals. 

1.1 Main features of V850ES/Fx3 – CAN it! 
• Easy to use device demonstration capabilities 

V850ES/Fx3 – CAN it! contains elements to easily demonstrate simple I/O-functions, i.e. push 
buttons, 12*2 character LC display, LED output, AD reference voltage, I/O lines, UART serial 
interface, LIN and CAN serial interfaces. 

 
• TK-V850 debugging 

The V850ES/Fx3 – CAN it! supports an On-Board debug function by using the IAR C-SPY debugger 
and the UART / USB interface without a need of additional debug hardware. It allows FLASH 
programming and supports standard debug functions i.e. code execution, single stepping, software 
breakpoints, memory manipulation etc. 
 

• N-Wire debugging 
The V850ES/Fx3 – CAN it! is prepared to be equipped with a 20-pin connector in order to connect 
the QB-V850MINI-EE On-Chip debug emulator to use On-Chip debug function of the V850ES/FG3 
device. Please note, the QB-V850MINI-EE is separate product from NEC and it is not included in this 
starterkit package. 
 

• Power supply via USB interface 
V850ES/Fx3 – CAN it! is powered via USB interface, no separate power supply is needed. 
 

• Character LCD module 
V850ES/Fx3 – CAN it! provides a 12*2 character LC display, allowing the implementation of human / 
machine interfaces, comfortable input / output functions, output of measurement values, output of 
status information etc.  
 

• FPL, FLASH programming software 
A windows based FLASH programming software allows to select and download application programs 
to the V850ES/Fx3 – CAN it! board for evaluation purposes. 

 
• Analogue to digital signal conversion is supported 

 
• Various input / output signals available, such as 
 

° I/O ports prepared to be connected to user hardware 
° Timer input / output signals 
° Two or three wire serial I/O 
° UART interface, via USB UART chip FT232 
° High Speed CAN bus interfaces with transceiver PCA82C250 
° LIN bus support, via TJA 1020 transceiver 
° 16 analogue input lines 
° Temperature sensor KTY13-5 
° 4 I/O ports connected to LED 
° 2 push buttons prepared for external interrupt generation 
 

• The IAR Embedded Workbench for V850 and the IAR C-SPY debugger / simulator are included. This 
package is restricted in such that maximum program code size is limited to 16 kByte. 

 
• Full documentation is included for the NEC V850ES/FG3 microcontroller, IAR Systems Embedded 

Workbench, IAR Systems C-SPY debugger / simulator and the NEC FPL FLASH programming 
software. 
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V850ES/Fx3 – CAN it! is not intended for code development. NEC does not allow and does not 
support in any way any attempt to use V850ES/Fx3 – CAN it! in a commercial or technical product. 
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1.2 System requirements 
 
HOST PC A PC supporting Windows 98SE, Windows ME, Windows 2000 or 

Windows XP is required for the IAR Systems Embedded Workbench 
demo-version and the FPL FLASH programming software. 
Pentium 166 MHz (at least), 128 MB of RAM, 256-color display (1024 * 
768), mouse, CD-ROM drive and 200 Mbytes of free hard disk space are 
required to install the tool packages. 
 
Above listed requirements are valid for the IAR Systems Embedded 
Workbench and the FPL FLASH programming software. 
 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
 

 

1.3 Package contents 
Please verify that you have received all parts listed in the package contents list attached to the  
V850ES/Fx3 – CAN it! package. If any part is missing or seems to be damaged, please contact the dealer 
from whom you received your V850ES/Fx3 – CAN it! starterkit. 
 
Note: Updates of the IAR Embedded Workbench for V850, FP3 FLASH programming software, 

documentation and/or utilities for V850ES/Fx3 – CAN it!, if available, may be downloaded from 
the NEC WEB page(s) at http://www.eu.necel.com/updates 

 
 

1.4 Trademarks 
IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered trademarks of IAR 
Systems AB. Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and 
Acrobat Reader are registered trademarks of Adobe Systems Incorporated.  
 
All other product names are trademarks or registered trademarks of their respective owners. 
 

http://www.eu.necel.com/updates
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2. V850ES/Fx3 – CAN it! system configuration 
 
The V850ES/Fx3 – CAN it! system configuration is given in the diagram below: 
 

 
Figure 1: V850ES/Fx3 – CAN it! system configuration 

2.1 V850ES/Fx3 – CAN it! 
V850ES/Fx3 – CAN it! is a demonstration kit for the V850ES/FG3 32-Bit RISC microcontroller. The 
V850ES/Fx3 – CAN it! board is connected to the host system via a USB interface cable. The host system 
may be used for On-Board debugging of application software by using the IAR C-SPY debugger or the 
programming of the V850ES/FG3 internal FLASH memory by using the FPL programming GUI, to allow 
execution of application programs on the V850ES/Fx3 – CAN it! starterkit hardware. 
 
The V850ES/Fx3 – CAN it! is equipped within an 4.0000 MHz crystal oscillator. This allows running the 
V850ES/FG3 device at a speed of 32 MHz by using the internal PLL of the microcontroller. 
 

2.2 Host computer 
The USB host interface enables communication to the V850ES/Fx3 – CAN it! board. The USB UART chip 
FT232 allows application software to access the USB device in the same way as it would access a 
standard RS232 interface. The FTDI's Virtual COM Port (VCP) driver appears to the windows system as 
an extra Com Port, in addition to any existing hardware Com Ports.  
 

2.3 Power supply via USB interface 
V850ES/Fx3 – CAN it! is powered by USB interface, no separate power supply is needed. The USB 
interface provides the V850ES/Fx3 – CAN it! board with 5V supply voltage. 
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3. V850ES/Fx3 – CAN it! baseboard components 
 
The V850ES/Fx3 – CAN it! baseboard is equipped with push buttons, a 12*2 character LC display, LED’s 
and with several connectors in order to be connected to host computers, FLASH programmer and LIN 
busses. 
 

 
Figure 2: V850ES/Fx3 – CAN it! baseboard connectors, switches and LED’s 

 
Some of the V850ES/Fx3 – CAN it! components are free for user application hardware and software. 
Please read the user’s manual of the V850ES/FG3 device carefully to get information about the electrical 
specification of the available I/O ports before you connect any external signal to the V850ES/Fx3 – CAN 
it! board. 
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3.1 RESET button SW1 
SW1 is a reset button. It activates the power on reset. It is connected to the reset input of the 
V850ES/FG3 CPU module. 

3.2 User button SW2 
SW2 is a push button connecting VCC to external interrupt input INTP4 of the microcontroller. This is equal 
to port P913 of the V850ES/FG3 device. The port may be programmed to generate interrupt INTP4. The 
necessary initialisation for this purpose is described in the user’s manual of the V850ES/FG3 device. The 
port is connected to a 4.7K pull down resistor. 

3.3 User button SW3 
SW3 is a push button connecting VCC to external interrupt input INTP5 of the microcontroller. This is equal 
to port P914 of the V850ES/FG3 device. The port may be programmed to generate interrupt INTP5. The 
necessary initialisation for this purpose is described in the user’s manual of the V850ES/FG3 device. The 
port is connected to a 4.7K pull down resistor. 
 

3.4 Configuration switch SW4 
The different operation modes of the V850ES/Fx3 – CAN it! board can be set by SW4 switches S1-S4.  
 

SW4 Factory settings Functionality 
S1 OFF Operation mode select 
S2 OFF TK-V850 / FPL mode select 
S3 OFF UART/ LIN mode selection 
S4 OFF User switch 

Table 1: Configuration switch SW4, factory settings 

3.4.1 Operation mode selection SW4/S1 
SW4 switch S1 controls the operation mode of the V850ES/Fx3 – CAN it! board. Setting SW4/S1 to ON 
enables the TK-V850 On-Board debug function. Additional On-Board FLASH programming by using the 
FPL software is supported in this mode. 
 
Within normal operation mode (setting SW4/S1 to OFF) the user program stored in the internal FLASH 
memory of V850ES/FG3 device is executed. Additional debugging via N-Wire interface and FLASH 
programming via the PG-FP4 FLASH programmer is supported in this mode. 
 

SW4, S1 Operation mode 
OFF Normal operation mode 
ON TK-V850 debugging / FPL FLASH programming 

mode 

Table 2: Operation mode selection SW4/S1 

 
For more details on how to configure V850ES/Fx3 – CAN it! in order to use On-Chip debugging please 
refer to CHAPTER 5, ON-CHIP DEBUGGING. 
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3.4.2 TK-V850 / FPL mode selection switch SW4/S2 
SW4 switch S2 selects the TK-V850 On-Board debugging or FPL FLASH programming mode. Setting 
SW4/S2 to OFF enables the TK-V850 On-Board debug function. Switching SW4/S2 to ON allows On-
Board FLASH programming by using the FPL FLASH programmer software. 
 

SW4, S2 Operation mode 
OFF TK-V850 debugging mode 
ON FPL FLASH programming mode 

Table 3: TK-V850 / FPL mode selection switch SW4/S2 

 
For more details on how to configure V850ES/Fx3 – CAN it! in order to use On-Chip debugging please 
refer to CHAPTER 5, ON-CHIP DEBUGGING. 
 

3.4.3 UART/ LIN mode selection SW4/S3 
SW4 switch S3 controls the serial communication mode of V850ES/Fx3 – CAN it! board. Setting SW4/S3 
to OFF connects the UARTD0 receive and transmit signals to the FT232 interface lines and the UARTD2 
receive and transmit signals to the TJA1020 LIN transceiver. Switching SW4/S3 to ON connects the 
UARTD0 and UARTD2 signals vice versa. 
 

SW4, S3 Operation Mode 
OFF UARTD0 connected to FT232 UART chip 

UARTD2 connected to TJA1020 LIN transceiver  
ON UARTD0 connected to TJA1020 LIN transceiver 

UARTD2 connected to FT232 UART chip 

Table 4: UART/ LIN mode selection SW4/S3 

 
By using the TK-V850 debugging / FPL FLASH programming mode set switch SW4/S3 to OFF. UARTD0 
is reserved as communication channel for On-Board debugging or FLASH programming and can not be 
used by a user program. 
 

3.4.4 User switch SW4/S4 
SW4 switch S4 is connected to port P911 of the V850ES/FG3 device. This switch can be freely used by 
the user software. Switching SW4/S4 to ON applies VSS to port P911. 
 

SW4, S4 V850ES/FG3 
OFF VCC applied to P911 
ON VSS applied to P911 

Table 5: User switch SW4/S4 

 

3.5 LIN plug JP1  
JP1 is a 3 pin connector for the LIN bus, connected to the transceiver TJA1020. 
 

JP1 Signal Description 
1 BAT Reference voltage for the LIN bus level 
2 LIN LIN bus line 
3 GND Ground 

Table 6: LIN plug JP1 

 



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       18 

 

3.6 USB interface connector CN6 
The CN6 connector allows connecting the IAR C-SPY debugger or FPL FLASH programming software to 
the V850ES/Fx3 – CAN it! board in order to debug application software or program the V850ES/FG3 
internal FLASH memory. The board power supply of 5V is also provided by connector CN6. 
 
For standard communication to a host system, i.e. by using a terminal program, the input/output signals 
of UARTD0 respectively UARTD2 of the V850ES/FG3 device are connected to CN6. Please configure 
switch SW4 accordingly to use this mode. 

1 5

 
Figure 3: Connector CN6, USB Mini-B Type Host Connector Pin Configuration 

 
 

USB Connector 
CN6 

Signal 

1 VBUS 
2 DM 
3 DP 
4 N.C. 
5 GNDBUS 

Table 7: Pin Configuration of USB Connector CN6 

 
For connection with the host machine, use a USB cable (Mini-B type). For confirmation, 
NEC Electronics used only the USB cable delivered with the V850ES/Fx3 – CAN it! board. 
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3.7 Connector CN4 
CN4 connector (not assembled) allows connecting the PG-FP4 flash programmer to V850ES/Fx3 – CAN 
it! board in order to program application software into the FLASH memory of the V850ES/FG3 device. 
Please note, PG-FP4 is a separate product from NEC and it is not included in this package. 
 
 

CN4 Signal 
1 GND 
2 RESET 
3 SI 
4 VCC 
5 SO 
6 N.C. 
7 SCK 
8 N.C. 
9 N.C. 
10 N.C. 
11 N.C. 
12 FLMD1 
13 N.C. 
14 FLMD0 
15 N.C. 
16 N.C. 

Table 8: CN4, PG-FP4 connector 

 
When using PG-FP4, the programming interface to the V850ES/FG3 device must be set to clock serial 
interface, CSI. Set configuration of switch SW4 of the V850ES/Fx3 – CAN it! board to the following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 Don’t care 
S4 Don’t care 

Table 9: SW4 configuration when using PG-FP4 

 

3.8 External Potentiometer R7 
A 47K potentiometer R7 is connected between Vcc and ground. The potentiometer arm is connected to 
the V0 signal of the LCD module. It controls the operating voltage - contrast adjustment - of the display. 
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3.9 Display D1, 12*2 character LC display 
The V850ES/Fx3 – CAN it! board is equipped with a character LC display. The display font is equal to 12 
character words at 2 lines. The LCD module contains about a character generator ROM - including 
predefined standard characters - and a character RAM where the user can define its own characters. The 
display is connected to the V850ES/FG3 device via three control lines and eight data lines. 
 
 

Display Pin Display Signal V850ES/FG3 Signal V850ES/Fx3 - CAN it! 
baseboard 

1 Vss - GND 
2 Vcc - Vcc 
3 V0 - R7 potentiometer arm 
4 RS PDL12 - 
5 R/W PDL13 - 
6 E PDL7 - 
7 DB0 PDL0 - 
8 DB1 PDL1 - 
9 DB2 PDL2 - 

10 DB3 PDL3 - 
11 DB4 PDL8 - 
12 DB5 PDL9 - 
13 DB6 PDL10 - 
14 DB7 PDL11 - 
15 A - Vcc via diode 

Table 10: Display connections 

 
For more details about the LC display specification, commands and character table, please refer to the 
corresponding User’s Manual “WH1202A-NFA-ET.pdf” located in the /doc folder of the V850ES/Fx3 – 
CAN it!. 
 

3.10 External Potentiometer R14 
A 47K potentiometer R14 is connected between Vcc and ground. The potentiometer arm is connected to 
port P713 of V850ES/FG3 device. This is equal to the ANI13 analogue input. 
 

3.11 AD converter reference voltage input 
A 1.2V reference voltage is supplied to the ANI14 analogue input, equal to port P714 of V850ES/FG3 
device. 
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3.12 Temperature sensor 
For temperature measurement and primarily as an application example a silicon temperature sensor 
KTY13-5 is connected to the ANI15 analogue input, equal to port P715 of V850ES/FG3 device. 
 
The temperature sensor has a resistor range of R25 min = 1950 • and R25 max = 1990 • at 25 degrees 
centigrade, with IOP = 1mA. The distribution of the temperature factor kT is shown in the table below: 
 

 
Table 11: Distribution of temperature factor kT 

 
The sensor resistance can be calculated as following:  RT =  kT * R25 =  •(TA) 

 

 
  1) Normalising point 
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The temperature at the sensor can be calculated from the change in the sensors resistance from the 
following equation, which approximates the characteristic curve: 
 
 

 
 
 

3.13 External LED’s D1–D4 
LED’s D1 to D4 are connected to port PCT of the V850ES/FG3 device. A low signal output at each port 
switches the corresponding LED on. 
 
 

LED V850ES/FG3 Signal 
D1 PCT0 
D2 PCT1 
D3 PCT4 
D4 PCT6 

Table 12: LED D1–D4 connection 

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:
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4. V850ES/Fx3 – CAN it! CPU module components 
The V850ES/FG3 CPU module is equipped with 2 connectors CN7 and CN8 in order to be connected to 
user defined hardware. Additionally the V850ES/FG3 CPU module contains about connector CN9 (not 
assembled) for N-Wire debugging and connectors CN3, CN4 and CN6 for CAN communication purpose. 
 

4.1 V850ES/Fx3 – CAN it! CPU module 
 

 
 

                                   Figure 4: V850ES/Fx3 – CAN it! CPU module components 
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4.1.1 External connector CN7 and CN8 
CN7 and CN8 are connectors for external user hardware. The following signals of the V850ES/FG3 
microcontroller are connected to CN7 and CN8: 
 

CN7 V850ES/FG3 Signal CN7 V850ES/FG3 Signal  
1 P99, SCKB1, TIAB00, TOAB00 2 P79, ANI9  

3 PCS0 4 P78, ANI8  

5 PCS1 6 P77, ANI7  

7 PCM0 8 P76, ANI6  

9 PCM1, CLKOUT 10 P75, ANI5  

11 PCM2 12 P74, ANI4  

13 PCM3 14 P73, ANI3  

15 P712, ANI12 16 P72, ANI2  

17 P711, ANI11 18 P71, ANI1  

19 P710, ANI10 20 P70, ANI0  

Table 13: Connector CN7 

 
CN8 V850ES/FG3 Signal CN8 V850ES/FG3 Signal  
1 P10, INTP9 2 P51, KR1, TIAB02, TOAB02, TOAB0B1  

3 P11, INTP10 4 P90, KR6, TXDD1  

5 P00, TIAA31, TOAA31 6 P91, KR7, RXDD1  

7 P01, TIAA30, TOAA30 8 P92, TIAB11, TOAB11  

9 P02, NMI, TIAA40, TOAA40 10 P93, TIAB12, TOAB12  

11 P03, INTP0, ADTRG, TIAA41, TOAA41 12 P94, TIAB13, TOAB13  

13 P04, INTP1, CRXD0 14 P95, TIAB10, TOAB10  

15 P32, ASCKD0, TOAA01, TIAA00, TOAA00 16 P96, TIAA21, TOAA21  

17 P35, TIAA11, TOAA11 18 P97, SIB1, TIAA20, TOAA20  

19 P50, KR0, TIAB01, TOAB01, TOAB0T1 20 P98, SOB1, TIAB03, TOAB03  

Table 14: Connector CN8 

 

4.2 High Speed CAN connector CN6 
CN6 is a D-SUB 9 connector for High Speed CAN with CiA standard pin assignment. The used CAN 
transceiver is the PCA82C250 with bus termination. The transceiver is connected to the CAN0 interface 
of the V850ES/FG3 device per default, whereby the standby mode control is selected by port P915. 
 
 

CN6 Signal 
1 N.C. 
2 CANL 
3 GND 
4 N.C. 
5 N.C. 
6 N.C. 
7 CANH 
8 N.C. 
9 N.C. 

Table 15: CAN connector CN6 
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4.3 CAN connectors, CN3 and CN4 
By closing the connectors CN3 and CN4 (not assembled) both CAN macros of the V850ES/FG3 device 
are connected via a PCA82C250 CAN transceiver each. Within this mode a simple CAN network with two 
CAN nodes can be simulated. 
 

 
           Figure 5: CAN transceivers 

 
The CAN0 interface of the V850ES/FG3 device is connected to transceiver IC3, whereby the standby 
mode control of the CAN transceiver is selected by port P915. 
The CAN1 interface of the V850ES/FG3 device is connected to transceiver IC2, whereby the standby 
mode control of the CAN transceiver is selected by port P912. 
 
 

4.4 External power supply input, CN5 
By using connector CN5 (not assembled) external power supply can be applied to the V850ES/Fx3 – 
CAN it! board without a need of an active USB connection.  
 

CN5 Input 
1 GND 
2 VDD (+5V) 

Table 16: External power supply input, CN5 

 
Note: Be sure to unplug the USB connection before applying external power supply to input CN5. 
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4.4.1 N-Wire connector CN9 
Connector CN9 (not assembled) allows connecting the QB-V850MINI-EE On-Chip debug emulator to the 
V850ES/Fx3 – CAN it! board in order to use the N-Wire debug function of the V850ES/FG3 device.  
QB-V850MINI-EE is a separate product from NEC and it is not included in this starterkit package. 
 
 

CN9 Signal CN9 Signal 
1 GND 2 DCK 
3 GND 4 DMS 
5 GND 6 DDI 
7 GND 8 DRST 
9 GND 10 N.C. 
11 GND 12 RESET 
13 GND 14 FLMD0 
15 GND 16 N.C. 
17 GND 18 DDO 
19 GND 20 VCC 

Table 17: N-Wire connector CN9 

 
To enable N-Wire debugging by using the QB-V850MINI-EE, please set switch SW4 to the following 
configuration: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 Don’t care 
S4 Don’t care 

Table 18: SW4 configuration for OCD via QB-V850MINI-EE 

 
For more details on how to configure V850ES/Fx3 – CAN it! in order to use On-Chip debugging please 
refer to CHAPTER 5, ON-CHIP DEBUGGING. 
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5. On-Chip debugging 
The V850ES/Fx3 – CAN it! board offers two possibilities to use On-Chip debugging. The TK-V850 debug 
function of V850ES/Fx3 – CAN it! allows On-Chip debugging without a need of external debug hardware. 
Within this mode the default USB / UART connection to the Host computer is used as debug interface. All 
standard debug functions are available in the On-Board debugging mode like FLASH programming / 
downloading, code execution, single stepping, breakpoints, memory manipulation etc. 
 
Additionally V850ES/Fx3 – CAN it! supports N-Wire debugging by using the QB-V850MINI-EE On-Chip 
debug emulator in order to use On-Chip debug function of the V850ES/FG3 device. The system 
configuration for On-Chip debugging is shown in the figure below. 
 

 
 

 Figure 6: Configuration for On-Chip debugging 

 

5.1 OCD via TK-V850 debugging 
To operate the V850ES/Fx3 – CAN it! board within the On-Board debug mode configure switch SW4 as 
following: 
 
 

SW4 Setting 
S1 ON 
S2 OFF 
S3 OFF 
S4 Don’t care 

Table 19: SW4 configuration for TK-V850 debugging 
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5.2 OCD via N-Wire debugging 
To operate the V850ES/Fx3 – CAN it! board together with the QB-V850MINI-EE On-Chip debug emulator, 
configure switch SW4 as following: 
 
 

SW4 Setting 
S1 OFF 
S2 OFF 
S3 Don’t care 
S4 Don’t care 

         Table 20: SW4 configuration for N-Wire debugging 

 
 
 



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       29 

 

6. V850ES/Fx3 – CAN it! installation and operation 

6.1 Getting started 
The IAR C-SPY debugger allows to download and debug application software on the V850ES/Fx3 – CAN 
it! starterkit hardware. Additionally the FPL FLASH programming software can be used for simple FLASH 
programming of the V850ES/FG3 internal FLASH memory. As communication interface between the host 
computer and the V850ES/Fx3 – CAN it! board a USB interface line is needed. Before you can download, 
debug or execute an application program, hardware and software must be installed properly. 
 
 

6.1.1 CD-ROM contents 
The CD-ROM shows following directory structure: 
 

 V850ES/Fx3 – CAN it! (F:) CD-ROM ROOT 

  Acrobat - Acrobat Reader for 32Bit Windows OS 
 

  Doc - Documentation 
 

  FPL - FPL FLASH programming software 
 

   Drivers  … USB driver 
 

   FPL  … FPL setup directory 
 

   PRM  … PRM parameter files 
 

  IAR Embedded Workbench V850 - IAR Embedded Workbench for V850 
 

  SamplePrograms - Sample programs for V850ES/Fx3 – CAN it! 
 

  TK-V850 Driver - TK-V850 Driver for V850ES/Fx3 – CAN it! 
 

   DDF  … Device Description File and 
 … SFR Description File for IAR C-SPY 

   DEVICES  … Menu File for IAR Embedded Workbench 
 

   NEC  … TK-V850 driver for IAR C-SPY 
 … Device File 

 

Table 21: V850ESFx3 – CAN it! CD-ROM directory structure  
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7. Hardware installation 
After unpacking V850ES/Fx3 – CAN it!, connect the board to your host computer using the provided USB 
interface cable. When V850ES/Fx3 – CAN it! is connected, the USB driver needs to be installed on the host 
machine. Please refer to the following CHAPTER 8 SOFTWARE INSTALLATION. 
 

8. Software installation 
The V850ES/Fx3 – CAN it! package comes with several software demo packages: 
 
• IAR Systems Embedded Workbench for V850, including C compiler, assembler, linker, librarian and IAR 

C-SPY debugger 
• TK-V850 Driver for V850ES/Fx3 – CAN it! 
• FPL FLASH programming software 
• Sample programs 
 
The IAR Systems Embedded Workbench and the FPL FLASH programming GUI must be installed on your 
PC. For detailed installation hints, refer to the following chapters and to the corresponding documentation of 
the IAR Embedded Workbench. 
 

8.1 IAR Systems Embedded Workbench for V850 installation 
To install the IAR Systems Embedded Workbench for V850 including C-SPY debugger, select the SETUP 
program in the directory \IAR Embedded Workbench V850\ewv850\ of the CDROM. The setup 
dialogues will guide you through the installation process. 
 

8.2 TK-V850 driver installation 
To install the TK-V850 driver for the V850ES/Fx3 – CAN it! in order to use the IAR C-SPY debugger and On-
Board debugging, select the SETUP program in the directory \TK-V850 driver\ of the CDROM. The 
setup dialogues will guide you through the installation process. 
 

8.3 FPL FLASH programming GUI installation 
To install the FPL FLASH programming GUI select the SETUP program in the directory \FPL\ of the 
CDROM. The setup dialogues will guide you through the installation process. 
 

8.4 Sample program installation 
To install the sample programs for the V850ES/Fx3 – CAN it! board select the SETUP program in the 
directory \SamplePrograms\ of the CDROM. The setup dialogues will guide you through the installation 
process. 
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8.5 USB Driver Installation 
 
When the V850ES/Fx3 – CAN it! board and FPL is used, the driver needs to be installed on the 
host machine. Install the driver according to the following procedure: 

 
Installation on Windows 98SE/Me .........  Page 31 
Installation on Windows 2000 ................  Page 33 
Installation on Windows XP ...................  Page 39 

 

8.5.1 Installation on Windows 98SE/Me 
 

1. When the V850ES/Fx3 – CAN it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for adding new hardware is started.  Click 
Next>. 

 

Figure 7:  Add New Hardware Wizard (Windows 98SE) 

 
 

 
2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 8: Search Method (Windows 98SE) 

 

Click.

Check that "Search for a 
suitable driver ..." is selected. 

Click.
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3. Check the "Specify a location" check box only and enter "C:\Program 

Files\NECTools32\FPL\DRIVER" in the address bar, then click Next>. 
 

Figure 9: Search Location Specification (Windows 98SE) 

 
 
 
 
 
 
 
 

備考  3.1 ソフトウエアのインストール先のフォルダを変更した場合は， 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

4. The window below is displayed.  Click Next>. 
 

Figure 10: Checking Driver to Be Installed (Windows 98SE) 

 
 

 
 

<1> Check "Specify 
a location" only. 

<3>  Click.

<2>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 
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5. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish.  The installation of the USB Serial Port driver is then automatically performed. 
 

Figure 11: Installation Completion (Windows 98SE) 

 
 

 
 

8.5.2 Installation on Windows 2000 
 

1. When the V850ES/Fx3 – CAN it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Click 
Next>. 

 

Figure 12: Found New Hardware Wizard 1 (Windows 2000) 

 

Click. 

Click.
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2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 13: Search Method 1 (Windows 2000) 

 
 
 

3. Check the "Specify a location" check box only, then click Next>. 
 

Figure 14: Driver File Location 1 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is selected. 

Click. 

Check that "Specify a 
location" only is checked.
ed.hed. 
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4. Enter "C:\Program Files\NECTools32\FPL\DRIVER" in the address bar, then click OK. 

 

Figure 15: Address Specification 1 (Windows 2000) 

 
 
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\FPL\DRIVER". 

 
 

5. Click Next>. 
 

Figure 16: Driver File Search 1 (Windows 2000) 

 
 

Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click.

Click.
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6. Click Finish to complete the installation of the USB driver. 

 

Figure 17: USB Driver Installation Completion 1 (Windows 2000) 

 
 
 

7. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 18: Found New Hardware Wizard 2 (Windows 2000) 

 
 

Click.

Click.
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8. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 
then click Next>. 

 

Figure 19: Search Method 2 (Windows 2000) 

 
 
 

9. Check the "Specify a location" check box only, then click Next>. 
 

Figure 20: Driver File Location 2 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is selected.

Click. 

Check that "Specify a 
location" only is checked. 
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10. Enter "C:\Program Files\NECTools32\FPL\DRIVER" in the address bar, then click OK. 

  

    Figure 21: Address Specification 2 (Windows 2000) 

               
  
 
 
 
 
 

Remark If the installation destination folder is changed at the time of GUI software installation, 
enter "new-folder\DRIVER". 

 
 

11. Click Next>. 
  

   Figure 22: Driver File Search 2 (Windows 2000) 

 
 

  
  
  

Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click.

Click.



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       39 

 
12. Click Finish to complete the installation of the USB driver. 

  

   Figure 23: USB Driver Installation Completion 2 (Windows 2000) 

                 
  
 

8.5.3 Installation on Windows XP 
 

1. When the V850ES/Fx3 – CAN it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Check 
that "Install from a list or specific ..." is selected, then click Next>. 

 

Figure 24: Found New Hardware Wizard 1 (Windows XP) 

 
 

 

Check that "Install from a list or 
specific ..." is selected. Click. 

Click.
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2. Check that "Search for the best driver in these locations." is selected.  Check the "Include 

this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL\DRIVER" in the address bar, then click Next>. 

 

Figure 25: Search Location Specification 3 (Windows XP) 

 
 

 
 
 
 
 
 

3. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 26: Windows XP Logo Testing 3 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

Click. 

<4>  Click.<3>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 
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4. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 27: USB Driver Installation Completion 1 (Windows XP) 

 

 
 

5. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 28: Found New Hardware Wizard 2 (Windows XP) 

 
 
 

Click. 

Check that "Install from a list 
or specific ..." is selected. Click. 
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6. Check that "Search for the best driver in these locations." is selected.  Check the "Include 
this location in the search:" check box and enter "C:\Program 
Files\NECTools32\FPL\DRIVER", then click Next>. 

 

Figure 29: Search Location Specification 2 (Windows XP) 

 
 
 
 
 
 
 
 
 

7. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 30: Windows XP Logo Testing 2 (Windows XP) 

 

 

<1> Check that "Search for the best 
driver in these locations." is 
selected. 

<2> Check "Include this location in 
the search:" only. 

<4>  Click.<3>  Enter "C:\Program Files\NECTools32\FPL\DRIVER". 

Click. 
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8. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 31: USB Serial Port2 Driver Installation Completion (Windows XP) 

 
 
 
 

 
 
 

Click. 
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8.6 Confirmation of USB Driver Installation 
 
After installing the two types of drivers, check that the drivers have been installed normally, 
according to the procedure below. When using the V850ES/Fx3 – CAN it! board in combination 
with FPL GUI, the information to be checked here is needed. 

 
 

By clicking the "Device Manager" tab, check that the drivers are installed normally. 
 

Figure 32: Device Manager 

 
 

For Windows 98SE/Me 
Caution  Do not select Update and Erase when communicating with the target 

device. 
 

For Windows 2000/XP 
Caution  Do not perform "Hardware Modification Scan" when communicating with the target 

device. 
 
 

Remark In the GUI port list box, the same communication port as COM? of USB Serial Port 
(COM?) needs to be selected. 

 
 If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to 

CHAPTER 11 TROUBLESHOOTING. 
 

 

Check that "USB Serial Port 
(COM?)" is present. 

Check that "USB High Speed 
Serial Converter" is present. 
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8.7 Driver Uninstallation 
 

The driver uninstallation program is installed on the host machine when the FPL software is 
installed. Use the procedure below for driver uninstallation. 

 
 

1. When using Windows XP, log on as the computer administrator. When using Windows 
2000, log on as the Administrator. 

 
2. Double-click in the order from "My Computer" to "(C:)" to "Program Files" to "NECTools32" 

to "FPL" to "DRIVER".  "Ftdiunin.exe" is displayed.  Double-click "Ftdiunin.exe". 
  

     Figure 33: Driver Uninstallation 

 
 
 

3. Click Continue. 
 

Figure 34: Driver Uninstaller 

 

Double-click.

Click.
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4. Click Finish to complete driver uninstallation. 
 

    Figure 35: Completion of Driver Uninstallation 

 
 

Caution If the GUI software is uninstalled earlier, "Ftdiunin.exe" is also deleted.  At this time, delete 
"USB Serial Port (COM?)" and "USB High Speed Serial Converter" from Device Manager 
manually. 

 
 

Click.
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9. FPL FLASH programming software 

9.1 Introduction 
 
The parameter file of the V850ES/FG3 device is installed automatically during installation of FPL 
GUI, folder <FPL install-path>\PRM. Nevertheless, newest version of parameter file for the 
µPD70F3377 device can by download from the NEC Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.eu.necel.com/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 6 
SOFTWARE INSTALLATION). 

 
 

9.2 Starting up the GUI Software 
 

  • GUI software startup 
 Select FPL.EXE from the start menu to start the FPL GUI software. 

 
 

 When the GUI software is started normally, the following screen appears. 
 

Figure 36: GUI Software Main Window 

 
 

Menu bar 

Toolbar 

Action log window 

Status bar 

Programmer 
parameter 
window

http://www.eu.necel.com/updates
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This window consists of the following items: 

   
Name Display Information 
Menu bar 
(displayed at the top) 

Displays menu items executable by the 
FPL. 

Toolbar 
(displayed under the menu bar) 

Displays frequently used commands as 
icons. 

Action log window 
(displayed under the toolbar) 

Displays an FPL action log. 
 

Programmer parameter window 
(displayed to the right of the action log 
window) 

Displays programming parameter 
settings. 
 

Status bar Displays status. 
 
 

9.3 Toolbar 
 

The toolbar contains buttons for starting the important procedures of the FPL. 
 

Figure 37: Toolbar Buttons 

 
[Device] → [Setup] button 

 
[File] → [Load] button 

 
[Device] → [Blank Check] button 

 
[Device] → [Erase] button 

 
[Device] → [Program] button 

 
[Device] → [Verify] button 

 
[Device] → [Autoprocedure(EPV)] button 
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9.4 Menu Bar 
 
Depending on the actual device status and device type, some menu items may be enabled or 
disabled. 

 
 

9.4.1 [File] menu 
Clicking the [File] menu displays the pull-down menu as shown below. 
This menu mainly contains commands related to file operation. 

 

       Figure 38: [File] Menu 

 
 

(1) [Load] command 
The [Load] command allows you to select a program file. 
The selected program file is programmed into the flash memory of the device by 
executing the [Program] command or [Autoprocedure(EPV)] command. 

 

Figure 39: HEX File Selection Window 

 
 

 The file selection window for program loading displays the most recently used directory to 
which a user program has been loaded.  After a user program is loaded, a checksum 
calculation is made and the result is displayed in the programmer parameter window. 

 [  Open  button] 
 Selects a user program as a program to be written to the target device. 

 
 [  Cancel  button] 
 Closes the window without selecting a program. 
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(2) [Quit] command 
 The [Quit] menu is the command for terminating the FPL GUI software.  Clicking  ×  on the 

right side of the task bar also terminates the FPL GUI software. 
 User settings are saved in the FPL.ININote file, so that the GUI software starts up next time 

with the same settings. 
 

Note FPL.INI is created in the Windows folder when Windows 98SE, Windows Me, or 
Windows XP is used. 

 When Windows 2000 is used, FPL.INI is created in the Winnt folder. 
 
 

9.4.2 [Device] menu 
Clicking the [Device] menu displays the pull-down menu as shown below. 
This menu mainly contains commands for programming operations such as deletion, 
programming, and verification on the target device. 

 

Figure 40: [Device] Menu 

 
 

(1) [Blank Check] command 
The [Blank Check] command allows you to make a blank check on the target device 
connected to the FPL.  If the flash memory of the target device is erased, a blank 
check is terminated normally.  If the flash memory is not completely erased, the 
indication "not blank" is provided.  Before starting programming, erase the flash 
memory of the target device. 

 
(2) [Erase] command 

The [Erase] command erases the flash memory of the target device connected to the 
FPL.  While the flash memory is being erased, the progress status is displayed in the 
action log window to indicate programmer operation. 
The execution on the [Blank Check] command before the [Erase] command is 
executed follows the setting of 'Command options' of the Advance tab displayed by 
selecting [Device] → [Setup]. 
Upon completion of [Erase] command execution, the GUI software displays the result 
of executing the command on the target device. 
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(3) [Program] command 
The [Program] command sends a specified user program to the target device and 
writes the program to the flash memory. 
The execution of Verify operation for detecting an error in user program 
communication from the FPL to the target device after the execution of the [Program] 
command follows the setting of the 'Command options' on the Advance tab displayed 
by selecting [Device] → [Setup]. 
During programming, the progress status is displayed in the action log window to 
indicate programmer operation.  This progress status display window displays the 
progress status on target device programming by percentage. 
Upon completion of [Program] command execution, the GUI software displays the 
result of executing the command on the target device. 

 
(4) [Verify] command 

The [Verify] command sends a specified user program to the target device connected 
with the FPL, and performs verification against the data written to the flash memory of 
the target device. 
During verification, the progress status is displayed in the action log window to 
indicate programmer operation.  This progress status display window displays the 
progress status of target device verification by percentage. 
Upon completion of [Verify] command execution, the GUI software displays the result 
of executing the command on the target device. 

 
(5) [Security] command 
 This command is not supported. 

 
(6) [Checksum] command 
 The [Checksum] command reads the checksum value of the target device connected with 

the FPL. 
 This value differs from the value displayed in the parameter window of the main window. 

 
(7) [Autoprocedure(EPV)] command 

The [Autoprocedure(EPV)] command executes the [Erase] command, [Program] 
command and [Verify] command in succession. 
When a user program is to be resent to the target device for comparison with the data 
written to the flash memory of the target device because of a user program 
communication error, execute the [Program] command by selecting [Device] → 
[Setup] and specifying 'Command options' on the Advance tab, then set the automatic 
execution of the [Verify] command. 
During EPV execution, the progress status is displayed in the action log window to 
indicate programmer operation.  For a selected command, its execution operation, 
and messages, refer to CHAPTER 8 HOW TO USE FPL. 
Upon completion of [Autoprocedure(EPV)] command execution, the GUI software 
displays the result of executing the command on the target device. 

 
(8) [Signature read] command 
 The [Signature read] command reads the signature information (device name, flash 

memory information, and so forth) of the target. 
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(9) [Setup] command 

The [Setup] menu allows you to make settings related to flash memory rewriting 
according to the user environment and to set command options.  Each time the GUI 
software is started, the most recently used parameter file (.PRM) is read and the 
settings are displayed.  The [Setup] menu allows you to modify the settings of items 
other than those items consisting of shadowed characters according to the user 
environment. 

 
(a) Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target 
device. 
The mode of communication with the target, the operating clock, and so forth differ 
depending on the device used.  For details, refer to the manual of the device used, when 
making settings. 
The window shown below is opened. 

 

Figure 41: Device Setup Window - Standard 

 
 

This window shows all basic options that can be set in accordance with the user 
environment and target device. 

 
[  OK  button] 
Clicking the  OK  button saves the settings on the Standard and Advance menus and 
closes the window. 

 
[  Cancel  button] 
Clicking the  Cancel  button closes the window without saving the settings on the 
Standard and Advance menus. 
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<1> Parameter file 
This file holds parameters and timing data required to rewrite the flash memory of the 
target device.  Do not modify the data in the parameter file because the data is 
related to the guarantee of rewrite data. 
The parameter file is protected by the checksum function.  If the checksum result 
indicates an error, the FPL does not accept the parameter file. 

 
 

Figure 42: Setup Window - Parameter File Selection 

 
 
 

 

Figure 43: Parameter File Selection Window 

 
 

[  PRM File Read  button] 
A window for specifying a parameter file is displayed.  Specify a desired file then 
click Open. 
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<2> Communication interface to device 
"Communication interface to device" is used to select a channel for communication 
between the V850ES/Fx3 – CAN it! board and host machine. 

 

Figure 44: Setup Window - Communication interface to device 

 
 

[Port list box] 
Select a channel for communication between the V850ES/Fx3 – CAN it! board and 
host machine. 
•  COM1 to COM16 

 
Remark Selectable ports can be checked using Device Manager.  For details, refer 

to CHAPTER 8.6 Confirmation of USB Driver Installation. 
 

[Speed list box] 
Select a communication rate for the selected communication channel from the 
following: 
•  9600 bps  
•  19200 bps  
•  38400 bps  

 
Remark For selectable communication rates, refer to the user's manual of the 

device used. 
 

<3> Supply oscillator 
"Supply oscillator" is used to select a clock that determines programming, data 
transfer, and a transfer rate. 

 

Figure 45: Setup Window - Supply Oscillator Selection 

 
 

[Frequency box] 
Sets the clock frequency of the target system. 
The range of operating frequency varies from one device to another.  So, check the 
specifications of the device used before making a setting. 
 
[Multiply rate] 
Specifies the division rate or multiplication rate of the target device. 
If the target device has an on-chip PLL circuit, enter a division rate or multiplication 
rate according to the use environment. 
The selectable division rate or multiplication rate differs depending on the device.  
Check the specifications of the device used before making a setting. 
If the target device does not have an on-chip PLL circuit, select "1.0". 
On the initial screen, the default setting is displayed according to the parameter file. 
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<4> Operation Mode 
The setting of "Operation Mode" may divide the flash memory of some target devices 
into blocks or areas. 
This menu is used to select an operation mode of the flash memory.  Some devices 
do not have the block and area division modes, and some devices have only one of 
the modes.  In these cases, a nonexisting mode is unchoosable. 

 

Figure 46: Setup Window - Operation Mode 

 
 

[When Chip is selected] 
The entire flash memory area of the target device is subject to rewrite processing. 
 
[When Block is selected] 
Specify the Block number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Block numbers where the flash memory of the 
target device is configured. 

 
[When Area is selected] 
Specify the Area number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Area numbers where the flash memory of the 
target device is configured. 
 
[Show Address check box] 
Specify whether numbers or addresses are displayed in the Start/End list boxes. 
If this check box is checked, addresses are displayed. 
If this check box is not checked, numbers are displayed. 

 
 
 



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       56 

(b) Advance setup 
The Advance setup menu is used to specify the command options and security flag 
settings. 
When "Advance" is clicked, the following window is displayed: 

 

Figure 47: Device Setup Window - Advance 

 
 

<1> Command options 
This dialog box is used to specify the FPL flash processing command options. 

 

Figure 48: Setup Window - Command options 

 
 

[Blank check before Erase check box] 
If this check box is checked, blank check is made before the Erase command or EPV 
command is executed. 
If the result of a blank check indicates OK, erase processing is not executed. 

 
[Read verify after Program check box] 
If this check box is checked, write data is sent from the programmer after execution 
of the Program command and EPV command, then the data is verified against the 
data written to the flash memory. 

 
[Security flag after Program check box]  Not usable 

 
[Checksum after Program check box] 
If this check box is checked, the flash memory checksum value of the target device is 
read from the target device after execution of the Program command and EPV 
command. 
This value differs from the value displayed in the parameter window of the main 
window. 

 
<2> Security flag settings  Not usable 
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9.4.3 [View] menu 
Clicking the [View] menu displays the pull-down menu shown below. 
This menu contains commands for setting whether to display the toolbar and status bar. 

 

Figure 49: [View] Menu 

 
 
 

(1) [Toolbar] command 
 Checking the [Toolbar] command displays the toolbar.  Unchecking the command hides the 

toolbar. 
 

 
(2) [Status Bar] command 
 Checking the [Status Bar] command displays the status bar.  Unchecking the command 

hides the status bar. 
 

 
 
 
 
 
 
 
 



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       58 

9.4.4 [Help] menu 
Clicking the [Help] menu displays the following pull-down menu: 

 

Figure 50: [Help] Menu 

 
 
 

(1) [About FPL] command 
 The [About FPL] command opens the program entry window as shown below and indicates 

the version. 
 Clicking  OK  terminates the display. 

 

Figure 51: About FPL Window 
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9.5 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 
 

Figure 52: Programmer Parameter Window 

 
 

[Device] 
Updated after communication with the target device to display information about the target 
device. 

 
[Parameter file] 
Updated after [Setup] command execution to display information about a read parameter file. 

 
[Load file] 
Updated after [Load] command execution to select information about a selected program file. 
 
[Connection to device] 
Updated after [Setup] command execution to display information about the connection with the 
target device. 
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10. How to use FPL FLASH programming software 
 

This chapter explains the basic operation of the FPL GUI for programming the V850ES/Fx3 – CAN it! 
board. This chapter covers how to start the system, execute the EPV command, and program the 
V850ES/FG3 target device. 
 
The conditions of the series of operations described in this chapter are as follows: 
 
Hardware configuration of V850ES/Fx3 – CAN it! : 
 
Base board :  V850ES/Fx3 – CAN it! 
Target device :  V850ES/FG3 (μPD70F3377) 
Clock :  4 MHz 
Voltage level :  5 V 
 
Software configuration of FPL: 
 
Parameter file: 70F3377.PRM 
Clock setting :  4 MHz Multiplied by 8 
Port :  COM8 (38400 bps) 
Operation mode: Chip 
Write HEX :  ADC_demo.hex  
Option setting :  Blank check before Erase 

 

10.1 Installing the FPL GUI software 
Install the FPL GUI software on the host machine you are using, by referring to CHAPTER 8 
SOFTWARE INSTALLATION (if the software has not been installed yet). 

 

10.2 Installing the driver 
Install the USB driver on the host machine you are using, by referring to CHAPTER 8 SOFTWARE 
INSTALLATION (if the driver has not been installed yet). 

 

10.3 Installing the parameter file 
The parameter file for the V850ES/FG3 device is installed automatically during installation of FPL 
GUI, folder <FPL install-path>\PRM. Nevertheless, newest version of parameter file for the 
μPD70F3377 device can by download from the NEC Electronics Web site. 
 
Download the parameter file for the PG-FP4 from the following NEC Electronics Web site: 
 

http://www.eu.necel.com/updates 
 
Copy the parameter file downloaded from the NEC Electronics Web site into sub-directory 
<FPL.EXE-install-path>\PRM created during GUI software setup (refer to CHAPTER 8 
SOFTWARE INSTALLATION). 

 

http://www.eu.necel.com/updates
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10.4 Connecting and starting 
 
<1> Set the V850ES/Fx3 – CAN it! board to the FLASH programming mode by switching SW4/S1 

and SW4/S2 to ON. The UARTD0 of the V850ES/Fx3 device is used as FLASH 
programming interface, therefore set switch SW4/S3 to OFF: 

 

 
 
 
 
 
<2> <Plug and Play> Connect the V850ES/Fx3 – CAN it! board with the host machine via the 

USB cable. If the connection was already done, press the reset button SW1 to release the 
FLASH programming mode. 

 

SW4 Setting 
S1 ON 
S2 ON 
S3 OFF 
S4 Don’t care 
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<3> Start the FPL GUI. 

 

Figure 53: GUI Software Startup Screen 

 
 

10.5 Setting the programming environment 
<1> Select [Device] → [Setup] from the menu bar. 
<2> The Standard dialog box for device setup is activated. 
 

Figure 54: <Standard Device Setup> Dialog Box 
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<3> Click PRM File Read to open the parameter file selection window. 
 Select the parameter file “70F3377.prm” then click Open. 
 

Figure 55: Parameter File Selection 

 
 

 
<4> From the Port list box, select the communication port that matches the host machine being 

used. Select the communication speed of the Host connection. 
 

Figure 56: Port Selection 

 
 

 
Remark Selectable ports can be checked using Device Manager.  For details, refer to  

CHAPTER 8.6 Confirmation of USB Driver Installation. 
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<5> Set "Supply oscillator" according to the specifications of the V850ES/Fx3 – CAN it! board,  

“Frequency = 4.00 MHz” and “Multiply rate = 8.00”. In "Operation Mode", please 
specify the “Chip” mode. The following figure shows the recommended settings: 

 

Figure 57: <Standard Device Setup> Dialog Box after Setting 

 
 
 

<6> Switch to the Advance dialog box. 
 

Figure 58: <Advance Device Setup> Dialog Box  

 
 

 
 <Command options>  

Blank check before Erase :  Checked 
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<7> Click the OK button.  The GUI software sets the parameters. 
 When the settings have been completed, the following screen is displayed: 

 

Figure 59: Completion of Parameter Setting 

 
 

10.6 Selecting a user program 
<1> Select [File] → [Load]. 
<2> Select a program file to be written to the target device, then click Open. 
 

Figure 60: After Downloading 

 
 

The display is updated.

"Success read HEX file." is displayed.

"PRM File Read OK." is displayed.

The display is updated.
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10.7 [Autoprocedure(EPV)] command execution 
Select [Device] → [Autoprocedure(EPV)] from the menu bar. 
When the [Autoprocedure(EPV)] command is executed, Blank Check → Erase → Program and 
FLASH Internal Verify are executed sequentially for the μPD70F3377 device. 

 

Figure 61: After EPV Execution 

 
 
  

10.8 Terminating the GUI 
Select [File] → [Quit] to terminate the GUI software. All settings executed so far are saved in the 
FPL.INI file, so that those settings can be reused when the GUI software is restarted. 

 

10.9 Execute “ADC_DEMO” application 
Set the V850ES/Fx3 – CAN it! board to the normal operation mode by switching SW4/S1 and 
SW4/S2 to OFF. < Plug and Play> the V850ES/Fx3 – CAN it! board to start in normal operation 
mode or press the reset button SW1 to release the normal operation mode. 

 

10.10 Restarting the GUI 
When the system is restarted, the same screen as shown in Figure 59 appears. 

 

"...finish" is displayed.
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11. TROUBLESHOOTING 
 

In driver installation, recognition based on Plug and Play is disabled. 
 

Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
 
 
The driver file cannot be found at a specified location. 

 
Cause: 
The FPL FLASH programming software may not be installed correctly. 
Action: 
Install the GUI software again by referring to CHAPTER 8 Software Installation. 

 
 

In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial 
Converter" is not displayed.  Alternatively, the "!" or "×" is prefixed. 

 
Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector from the USB port, then insert the USB connector 
again after a while. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
<1> When this product is connected to the personal computer, right-click the driver marked 

with "!" or "×". 
 Click Erase when displayed. 
<2> On Device Manager, execute [Hardware Modification Scan]. 
<3> Install the driver again with Plug and Play. 

 
Cause: 
The device may not be recognized (in the case of connection with the USB hub). 
Action: 
Try the following: 
•  Disconnect the USB connector, then insert the USB connector again. 
•  Connect the USB connector to another port of the USB hub. 

If the same symptom occurs, do not use the USB hub, but directly connect the connector to the 
USB port of the personal computer. 

 
 

When this product is connected with a personal computer, the "Add New Hardware 
Wizard" screen is displayed. 

 
Cause: 
If the USB connector of this product is not inserted into the USB port used at the installation 
time but into another USB port, this product may be recognized as a new hardware item. 
Action: 
Install the driver by referring to CHAPTER 8.5 USB Driver Installation. 
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Communication with the V850ES/Fx3 – CAN it! board is disabled. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
Check if "USB Serial Port" and "USB High Speed Serial Converter" are installed correctly by 
referring to CHAPTER 8.5 USB Driver Installation. 

 
Cause: 
The COM port selected via the “Port list box” within device setup menu of FPL may not be set 
correctly. 
Action: 
Set the port checked using Device Manager. 

 
Cause: 
The V850ES/Fx3 – CAN it! board is operating in normal mode. 
Action: 
Set the board to the FLASH programming mode by setting SW4 switches S1 and S2 to ON and 
connect UARTD0 signals to the FTDI USB/UART chip by switching SW4/S3 to OFF. 
 

 
Cause: 
The PRM file selected in [Device Setup] may be incorrect. 
Action: 
Use the corresponding PRM file that matches the target device. For information about the PRM 
file, refer to CHAPTER 9 FPL FLASH programming software. 

 
Cause: 
The setting of "Supply oscillator" in [Device Setup] may be incorrect. 
Action: 
Make a correct setting according to the specifications of the target device. 
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12. TK-V850 debugging 
 
Before using the On-Board debug function of the V850ES/Fx3 – CAN it! board together with the IAR C-SPY 
debugger it is necessary to install the USB driver first. The V850ES/Fx3 – CAN it! starterkit uses a monitor 
program for debugging purpose. The communication between the starterkit and the IAR C-SPY debugger - 
that is running on the personal computer - is done via the standard UART / USB connection. The monitor 
program is automatically downloaded to the starterkit in that case when the V850ES/FG3 internal FLASH 
memory was erased by the user i.e. by using the FPL. Therefore the user has not to take care about the 
monitor. 
 
As communication interface the build-in UARTD0 of the V850ES/FG3 device is used by the monitor. 
Consequently it can not be used by the user program. 
 
To set the V850ES/Fx3 – CAN it! starterkit to the On-Board debug mode configure SW4 as following: 
 

 

 
 
 
 

SW4 Setting 
S1 ON 
S2 OFF 
S3 OFF 
S4 Don’t care 
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12.1 Monitor resources 
The debugging feature of the V850ES/Fx3 – CAN it! starterkit has been realized by a monitor program that is 
running on the V850ES/FG3 device. Therefore, the following resources are reserved by monitor and can not 
be used by a user program. 
 

12.1.1 UARTD0 
The UARTD0 of the V850ES/FG3 device is reserved for the monitor program and can not be used by a user 
program. 
 

Device UART for 
Debugging 

Interrupt 
control flags 

Terminals used  

V850ES/FG3 (µPD70F3377) UARTD0 UD0RMK 
UD0SMK 

P30 / TXDD0 
P31 / RXDD0 

 
Additionally, please note the following points: 
 

• Do not change the control registers of UARTD0. 
• Do not change or disable the interrupt control / mask flags of UARTD0. 
• Do not change the port mode or port mode control registers for port bits P30 and P31. 
• Debugging functions like forcible break (debugger stop command) do not operate normally in the 

following states where the clock supply to UARTD0 is disabled: 
 

 IDLE mode 
 STOP mode 
 Main oscillation (fx) is stopped.  

 

12.1.2 Interrupt vectors 
The following interrupt vectors are used by the monitor program and can not be used by a user program. 
 

Device Interrupt vector 
address 

Function  

0x0060 – 0x0063 DBTRAP debug interrupt vector 
0x02C0 – 0x02C3 UARTD0 receive interrupt vector 

V850ES/FG3 (µPD70F3377) 

0x02B0 – 0x02B3 UARTD0 status interrupt vector 
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12.1.3 Reset vector 
When a user program is downloaded by using the IAR C-SPY debugger, the reset vector (address 0x0000) 
of the user program is replaced by the one of monitor program. The debugger moves the reset vector of the 
user program automatically to address 0x0004. The correction of the relative jump address is also done 
automatically by the debugger. 
 
Example: 

 
 

12.1.4 Memory area 
The monitor program is located in the highest FLASH block of the V850ES/FG3 device. Only 2 kByte of 
memory are allocated by the monitor program. 
 

Device Address range Function  
V850ES/FG3 (µPD70F3377) 0x0007F800 - 0x0007FFFF Reserved for monitor 

program 
 
Moreover, the monitor reserves 10 bytes of the global stack area by halting the user program, caused by a 
forcible break (debugger stop command) or a software breakpoint. 
 

12.1.5 Clock operation 
After releasing a reset, the monitor program sets the operation clock of the CPU to the maximum speed of  
32 MHz. The monitor program switches also to the maximum CPU speed of 32 MHz when releasing a 
forcible break (debugger stop command) or when the user program execution is stopped caused by a 
software breakpoint. After the user program execution is restarted (debugger go command) the monitor 
restores the previous CPU operation clock setting. 
 
Note:  Do not change the frequency of the external oscillator connected to the X1 and X2 pins. 

The baud rate calculation for UARTD0 is based on a 4 MHz input frequency, otherwise no 
communication to the V850ES/Fx3 – CAN it! starterkit can be established. 

 

12.1.6 Other limitations 
The watchdog timer can not be used. Please be sure to set the option bytes of the V850ES/FG3 device 
accordingly to allow the watchdog timer disable. 
 
The forcible break (debugger stop command) can not be used when the global interrupts were disabled by 
the user program (DI instruction). 
 

MOV _start, R31 

JMP R31 

 

0x0000 

0x0006 

0x0008 

0x0000 

0x0004 

0x000A 

MOV _start, R31 

JMP R31 

JR monitor 
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12.2 IAR sample session 
When everything is set up correctly the IAR Embedded Workbench can be started. To do so, start the 
Embedded Workbench from Windows “Start” menu > “Programs” > folder “IAR Systems” > “IAR Embedded 
Workbench Kickstart for V850”. The following screen appears: 
 

 
Figure 62: IAR Embedded Workbench 

 
Now select the option “Open exiting workspace” from the “File” menu and locate the sample project. Open 
the file “V850ESFX3_CANit.eww”. This is the workspace file that contains general information about the 
demonstration projects and settings. 
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After the demo workspace has been opened the projects contained in the workspace are displayed. Now 
click on the little “+” sign next to the “ADC_demo” project to show files that were part of the project. The 
screen should now look similar to this: 

 
Figure 63: IAR project workspace 

 
As a next step check some settings of the IAR Embedded Workbench that have to be made for correct 
operation and usage of the On-Board debug function of the V850ES/Fx3 – CAN it! board. First highlight the 
upper folder called “ADC_demo – Debug” in the workspace window. Then select “Project” > “Options” from 
the pull-down menus. Next select the category “Debugger”. Make sure that the driver is set to “TK-V850” in 
order to use the On-Board debug function of the V850ES/Fx3 – CAN it! board. The device description file 
must be set to “io70f3377.ddf” according to the V850ES/FG3 device. 

 
Figure 64: IAR debugger options 1/2 

Select “TK-V850” 
to use On-Board 
debugging. 

Check that device 
description file 
io70f3377.ddf  
is selected 
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Before using the On-Board debug function it is necessary to set the corresponding USB serial COM port of 
the host computer. To set the COM port, please select the category “TK-V850” and choose the 
corresponding serial port. 
 

 
Figure 65: IAR debugger options 2/2 

 
Next the correct linker settings of the demo project will be checked. This can be done in the “Linker” 
category as shown below. Select the “Config” tab and check that the linker command file “lnk70f3377.xcl” is 
selected. This file is used by the linker and contains information on where to place the different sections of 
code and data that may be used within the demo project: 
 

 
Figure 66: IAR Linker options 

Choose serial port

 



V850ES/Fx3 – CAN it!  

User’s Manual U18560EE1V0UM00                                                                       75 

 
Now after everything has been setup correctly it’s time to compile and link the demonstration project. Close 
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked 
without errors or warnings it can now be downloaded to the V850ES/Fx3 – CAN it! board and debugged.  

To start the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the ( ) 
“Debugger” button. In the next step the TK-V850 Emulator has to be configured before downloading a new 
application. Press the OK button to enter the hardware setup menu. Set the configuration as show in the 
figure below and start the download by pressing the OK button. 
 

 
              Figure 67: TK-V850 hardware setup menu 
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Now the debugger is started and the demo project is downloaded to the V850ES/Fx3 – CAN it! board. In 
other words, the FLASH memory of the V850ES/FG3 device is reprogrammed with the user application. The 
progress of downloading is indicated by blue dots in the TK-V850 Emulator window. 
 

 
         Figure 68: IAR project download 
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After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single 
Stepping (Step Over/-In/-Out), Go, Stop, Breakpoints, Register / Memory view etc. 
 
To get more details on the debugger configuration and capabilities please refer to the “V850 IAR Embedded 
Workbench IDE User Guide” of the IAR installation. 
 

 
Figure 69: IAR C-SPY debugger 
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13. Sample programs 

13.1 General Introduction 
Each of the sample programs is located in a single directory, which will be called main-directory of the 
sample. This main directory of each sample contains the complete project inclusive all output files of the 
development tool. The workspace file “V850ESFX3_CANit.eww” is located on top of the sample program 
directories. All sample programs use the same directory structure: 
 
 

 AD Converter Demonstration V850ES/FG3 project and output files 

  Debug  debug output files for IAR C-SPY debugger 

  inc  C header files 

  Release  release output files, i.e. Intel HEX file 

  settings  configuration files, IAR Embedded Workbench 

  source  C source files 

  xcl  Linker control file 

  ADC_demo.dep  dependency information file, IAR Embedded Workbench 

  ADC_demo.ewd  project setting file, IAR C-SPY debugger 

  ADC_demo.ewp  project file, IAR Embedded Workbench 

 CAN Demonstration V850ES/FG3 project and output files 

 Reaction Time Measurement V850ES/FG3 project and output files 

 Timer Demonstration V850ES/FG3 project and output files 

 UART Demonstration V850ES/FG3 project and output files 

 V850ESFX3_CANit.eww workspace file, IAR Embedded Workbench V850 

Table 22: Example directory structure 

 
The main directory contains only the project files for the IAR Systems Embedded Workbench V850. All 
source files are located in the directory /source and the /inc directory contains the header files. The /xcl 
directory contains the linker control file of the V850ES/FG3 device. Each sample project uses two targets. 
One target is the “Debug” (directory /Debug) that holds all information for debugging purpose and the other 
one the “Release” target (directory /Release) contains the programmable file, i.e. the Intel HEX file, for 
programming the V850ES/FG3 internal FLASH memory. 
 
All output files of the development tools for the corresponding target are generated in the directories /Debug 
and /Release. 
 
For details of using the IAR Embedded Workbench and the IAR C-SPY debugger please refer to the “V850 
IAR Embedded Workbench IDE User Guide”. 
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13.2 ADC demo 
This sample program realizes a simple voltage meter. By using the integrated ADC, the voltage supplied to 
ADC on input channel ANI13, port P713 of the V850ES/FG3 device is measured. The input voltage is 
adjusted by potentiometer R14. The board shows the measured voltage by driving the LC display. The 
output format can be changed by pressing button SW2. 
 

Used Internal Peripherals Used External Parts
TimerM Character LC display
A/D converter Potentiometer R14 
 Button SW2 
 Button SW3 
 LED’s D1- D4 

 
 

13.3 CAN demo 
This sample program simulates a simple CAN network consisting of two CAN nodes. By using the integrated 
ADC, the voltage supplied to the ADC input channel ANI13, port P713 of the V850ES/FG3 device is 
measured. The input voltage is adjusted by potentiometer R14. The measured voltage is transferred via 
CAN channel 0 to CAN channel 1 each 500ms. The transmit and receive status is shown on the LC display. 
Please close connectors CN3 and CN4 two connect both CAN transceivers and to allow communication. In 
case of an error frame or missing acknowledgement a fast recovery of the CAN channel is done. The 
communication can be restarted by pressing button SW3. 
 

Used Internal Peripherals Used External Parts
TimerM Character LC display
A/D converter Potentiometer R14 
CAN0 controller Button SW2 
CAN1 controller Button SW3 
 LED’s D1- D4 
 CAN transceiver IC2 
 CAN transceiver IC3 

 
 

13.4 ReacTime demo 
This sample program demonstrates a reaction time measurement. After the button SW3 is pressed the 
application waits for a random time duration between 0.50 and 5.45 seconds. Then the measurement starts 
by incrementing a reaction counter every 10ms. The actual counter value is shown by a bar graph using the 
character LC display until the next keystroke of button SW3. When the button SW3 is pressed again, the 
measurement stops and the reaction time is shown on the LC display. Pressing button SW2 starts a new 
measuring cycle. 
 
 

Used Internal Peripherals Used External Parts
TimerM Character LC display
TimerTAA0 Button SW2 
 Button SW3 
 LED’s D1- D4 
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13.5 Timer demo 
This sample program demonstrates a real time clock. After the program is started the TimerTAA0 is 
initialized to generate a clock reference, based on the 8 MHz main-clock. The actual time is displayed using 
the LCD module. By pressing button SW2 / SW3 the time can be adjusted. 
 
 

Used Internal Peripherals Used External Parts
TimerM Character LC display
TimerTAA0 Button SW2 
 Button SW3 
 LED’s D1- D4 

 
 
 
 

13.6 UART demo 
This sample program realizes a temperature meter with serial communication channel. The sample program 
does a cyclic measurement of the input voltage of ANI15 analogue input, equal to port P715 of V850ES/FG3 
device, connected to the temperature sensor KTY13-5. The temperature is calculated and the result is 
transferred via UARTD2 to a terminal program running on the host machine. The data transfer speed is set 
to 9600 bps per default. Additionally the temperature is displayed on the LCD. Before the temperature 
measurement is started the calibration of the temperature sensor has to be done, by adjusting the 
temperature offset via button SW2 and SW3. 
 
 

Used Internal Peripherals Used External Parts 
TimerM Character LC display 
TimerTAA0 Temperature sensor KTY13-5 
A/D converter Button SW2 
UARTD2 Button SW3 
 LED’s D1- D4 

 
 
Please note, by using the On-Board debug mode (TK-V850 debugging) serial communication via UARTD2 is 
not possible because the USB/UART communication channel is used for debugging purpose. To connect 
UARTD2 to the FTDI USB/UART chip please set switch SW4/S3 to ON. 
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14. USB interface cable (Mini-B type) 
 

 
Figure 70: USB interface cable (Mini-B type) 
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15. Schematics 

 
Figure 71: V850ES/Fx3 – CAN it! baseboard schematics
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Figure 72: V850ES/Fx3 – CAN it! CPU module schematics 
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